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Basic Principles
Tools
Mouse Usage



 Tools
Basic structure of viewSpace's interface is quite simple and can be described by only three guiding rules:

1. Tools are grouped by function onto a horizontal strip.
All tools are represented on the screen as icons, grouped by function, and selectable with the mouse.    
The entire range fits in the main window menu bar.

2. Many tools have variants, available from pop-up menus. 
Click and hold on a tool to see the variants, then drag to the variant and release to select it.

3. Some tools open Control and Property panels. 
 Some tools have control panels that open automatically when the tool is selected, and for further control, 
property panels that open when the tool is selected with the right mouse button:

That is it! There are no more "layers" to the interface, except for a few numeric entry requesters which 
can be opened by right clicking on some Control panel items.



Mouse Usage
Virtualy all trueSpace functions are mouse activated. Both mouse buttons are utilized but they operate 
differently, based on whether a tool or a 3D object is underneath the cursor.

Related Topics:
With Tools:
In the Workspace:



With Tools:
Left-click: Selects tool, opens control panel

Right-click: Opens property panel



In the Workspace:
Left Click: Select the object underneath the cursor.

Left button drag: Controls X and Y axis for Move, Rotate or Scale simultaneously.

Right button drag: Controls Z axis.

Both button drag: Proportional scaling.



Interface Notes
Following is a summary of important points concerning the viewSpace interface:

· To select a tool, click on it with the left mouse button. If the tool uses control panels to adjust 
settings, etc., they automatically open. Right-click on a tool to open its property panel, if it has one. These 
panels automatically go away when another tool is picked with the left mouse button.

· If you select a tool, then decide not to use it, simply move the mouse away from the tool before 
releasing the mouse button.

· Active, highlighted tool icons and settings buttons appear darker than when not in use, and 
appear to be "pushed in."    Also, tool icons that are not currently available, for example because no object
is selected, are "grayed" and cannot be selected.

· All tool groups automatically open in the main window menu bar.

· Control and property panels automatically open in a special left-to-right queue formation 
immediately above or below any displayed tool groups. If there is no more room for panels immediately 
next to the menu bar, the queue is continued immediately above (or below) the previous row. If a queued 
panel is closed or moved to a different part of the screen, the remaining panels close ranks (that is, those 
following the removed panel advance to fill in the gap).

· To place a panel at the end of the queue, drag it to within a few pixels of the menu bar or any 
groups thereon.

· To insert a panel at a specific location in the queue's first row, drag it to that location, placing the 
panel's bottom (or top) edge within a few pixels of the menu bar.

· To close a property panel manually, click the right mouse button on a button or blank gray area 
(not on a white area), then drag it outside the requester. When you see an X appear on the panel, release
the button to close it. If the Titles option is active (via Settings), you can also close a panel by clicking on 
the Close box at the left end of the panel's title bar.

·  A small mark in the upper left corner of a tool icon indicates that the tool has variants available 
from a pop-up graphic menu. A mark in the upper right corner indicates that there is a control panel 
associated with the tool for setting parameters.

· To access a variant menu for certain tools, click and drag slightly on the icon with the left mouse 
button, or simply click and hold for a moment. Keep the mouse button pressed down and drag to select a 
different item. 

· To access a variant's property panel without invoking the variant (e.g., Sweep), use the right 
mouse button, and drag to display the pop-up menu.

· To move a non-maximized (smaller than full-screen) view window, click on the blue text box near 
the lower left corner and drag the mouse.

· Initially the menu bar appears at the bottom of the screen; you can position it at the top by 
selecting the Top Menu item in the Edit menu's Settings panel (see below). If the viewSpace window is 
not at full-screen width, you may not be able to see all menu headings. 

· When multitasking viewSpace with other Windows programs, you may find upon returning to 
viewSpace that the screen colors have changed. To return to the default screen color scheme, simply 
click on any part of the screen except the menu bar.

· At the menu bar's right end are the standard Windows Minimize and Maximize/Restore gadgets.



Tools Overview
Navigation Groups
View/Render Group
Utility Group



Navigation Groups
Navigation in viewSpace refers to moving, rotating and scaling different types of objects as well as the 
viewpoint. The viewpoint is the "eye" through which the view is seen when a window is not set to Camera 
View. It can be positioned, rotated and scaled (zoomed), but unlike camera objects it cannot be seen. 
There are different Navigation tool groups for objects and each window's view.

The Object Navigation tool group is used for manipulating entire objects.

Object Move Tool
Object Rotate
Object Scale
There are individual View Navigation tool groups for each window. 

Eye Move Tool
Eye Rotate: Disabled in orthogonal views

Zoom

Related Topics:
Coordinate Systems



Coordinate Systems
Each Navigation tool group has its own Coordinates Property panel, which is accessed by right-clicking 
on any Navigation tool. This lets you set the current coordinate system, and constrain transformations to 
certain axes.

Any of three different coordinate systems can be used for any manipulation: world, object and 
screen..With all three, the left mouse button controls transformation on or around the X axis by mouse 
movement parallel to the X axis, and transformation on or around the Y axis by mouse movement parallel 
to the Y axis. The right mouse button controls transformation on or around the Z axis. Use the 
Coordinates Property panel to set the coordinate system as well as disable and enable transformations 
on any and all of the three axes.



View/Render Group
This group consists of the standard View Selection and Render tools found on all windows. 

Render: Used to render an image in solid mode. Variants include Render Object, Render Scene and 
Redraw Wireframe.

View Select Tool: Used to set the main view mode. Each window can be set to a different view, and with 
multiple cameras, each window can be set to show a different camera view. Variants are Perspective, 
Front, Left, Top and Camera.

Animation: Opens the Animation property panel. This icon only appears in the main window View/Render
group since only one is necessary for the whole scene.



Utility Group
This group contains special tools for adding windows and changing program settings.

New Window:    Adds an auxiliary window over the main view. Variants are New Perspective, New Front, 
New Left and New Top.

Settings Panel: Opens a panel for adjusting various global settings.

Again, pop-up menus containing tool variants, as indicated by a small mark in the upper left corner of the 
tool icon, are accessed by holding for a moment or dragging the mouse slightly on the icon to distinguish 
from merely selecting that icon. Then, to select a different item, you must drag the mouse to it before 
releasing the button. If the Help function is on, the tool variant names are shown in the help bar as you 
drag.

Also, some tools can be clicked on with the right mouse button to access related property panels. For 
example, right-clicking on any Navigation tool opens a property panel for setting the coordinate system 
and constraining transformations to specific axes.



Using Hot Keys
Each of viewSpace's tools can be activated by up to three different keyboard shortcuts. If the Help Bar 
option is active (see On-Line Help below), the help bar shows the first keystroke, if any, to the right of the 
description of the tool currently under the mouse pointer.

To add or change a keyboard shortcut for a tool, position the mouse pointer over the tool, then press the 
Control and F1 keys at the same time. The Key Shortcuts dialog box appears the tool's current key 
assignments, if any:

Related Topics:
New Key
Unset
Find



New Key
To create a new keyboard shortcut, click on the "New Key" button and then type the keystroke you want 
to use. You can use any combination of Control, Alt and Shift plus an alphanumeric, punctuation or 
function key. 



Unset
To remove a keyboard shortcut, click the "Unset" button next to the key description. 



Find
To find out what function is assigned to some key, click on the "Find" button and then type the keystroke 
you want to find the function of. If this keystroke has an assigned button then the dialog box will now 
display that button's description and any keyboard shortcuts defined for it.



Pre-Defined Hot Keys
Left and Right Arrows Select previous and next object in scene object list

Q Select Object Axes

W Select World Axes

E Select Screen Axes

A Toggle X Axis

S Toggle Y Axis

D Toggle Z Axis

Z Select Object Move

X Select Object Rotate

C Select Object Scale

P Play Animation

1 Toggle Draft Render mode

2 Toggle Raytrace Render option

3 Toggle Anti-aliasing in Rendering

Delete Delete current object



On-Line Help
By enabling the Help Bar option from the Help menu, you can take advantage of viewSpace's context-
sensitive help mode while learning the program and using unfamiliar tools. When the mouse pointer is 
positioned over any tool icon, the help bar displays its description plus a keyboard shortcut, used for 
accessing the tool from the keyboard.



Quitting the Program
At the menu bar's left end is viewSpace's Application Control menu box. Click on it once to open the 
Application Control menu. To quit the program, double-click on the box, or click once on the box, then on 
Close.

You can also quit by using the File menu's Exit command.



Introduction
This section is concerned with tools for the movement, rotation and scaling of objects. The concept here 
is easy to grasp. If you, say, rearrange your living room, you might pick up a vase and place it in a 
different location, or you might turn a painting so it's not hanging crookedly. Moving and rotating of objects
in viewSpace's 3D workspace isn't that different. To move an object to the side, you simply click on it with
the mouse and drag the mouse sideways, and viewSpace's instant feedback lets you see what's 
happening without delay. Rotation and scaling movement is similarly intuitive.

One of the problems people have with 3D graphics programs is that there is no direct correlation between
what you're doing with your hand and what's happening on the screen. With viewSpace, it takes 
practically no time to "get it," because what you do with your hand on the mouse directly relates to motion 
on the screen. When you use navigation tools to manipulate objects or the view, you can tailor movement 
to be natural, or to conform to strict parameters--it's up to you.

All such manipulation is fully interactive. With objects, you select what you want to manipulate, select the 
appropriate navigation tool, then click the mouse button or buttons in the view and drag.



Object Navigation Tools
The Object Navigation tools are used for moving, rotating and scaling entire objects.

Related Topics:
Object Selection Tool
Object Navigation
Object Move
Object Rotate
Object Scale
Coordinates Property Panel



Object Selection Tool
Select this tool, also called the Object tool, to enter object selection mode.

While this tool is active you can select different objects for navigation, etc.    You can also select different 
objects by repeatedly pressing the left and right cursor keys on your keyboard. This can help when many 
objects are loaded into the workspace.

Related Topics:
Object Property Panel



Object Property Panel
When the object tool is active, select it with the right mouse button to open the Object property panel, with
adjustable numerical entries for navigation and other settings. When the panel is open, using interactive 
navigation controls and selecting a different object updates the settings automatically.

Location
These three settings show the current object's position in trueSpace's world. The unit of measurement is 
a grid square. Change the position by clicking on the X, Y and Z boxes, entering a new value from the 
keyboard, and pressing Enter.

Rotation
These three settings show the current object's alignment in degrees. Change the alignment by clicking on
the X, Y and Z boxes, entering a new value from the keyboard, and pressing Enter.

Scale
These three settings show the current object's scaling in multiples of the original size. For example, if the 
X Scale is 2.5, the object is scaled two and one-half times larger on the X axis than its original size. 
Change the scale by clicking on the X, Y and Z boxes, entering a new value from the keyboard, and 
pressing Enter.

Name
This shows the object's name and lets you change it. Objects are automatically called NoName when 
created, so it's a good idea to use this function to give them more descriptive names. Click on the box 
under Name and enter a new name from the keyboard, then press Enter.

# Faces
This shows the number of faces or polygons in the current object. Since the only way to change this value
is by interactive editing, it cannot be changed in the property panel.



Object Navigation
The three Object Navigation tools let you manipulate the currently selected object. 

To use an Object Navigation tool, select it, then select an object and drag the mouse to perform the 
operation. When selected, an object's wireframe turns white. If Dynamic Pick is on , you can select the 
object and perform the operation without releasing the mouse button. When you have more than one 
window open and manipulate an object, all open windows reflect changes in real time as you make them.

Note: As with all navigation tools, the way the object reacts to your mouse movement is determined by the
coordinate system currently in effect. By right-clicking on any navigation tool, you can access the 
Coordinates property panel. This important tool lets you set the coordinate system for that tool to Object, 
World, or Screen, as well as constrain manipulation on individual axes.

Hint: If the object you want to manipulate is already selected, and is overlapped by other objects, and 
Dynamic Pick is on, to manipulate the object without inadvertently selecting an overlapping object, simply 
click on a spot away from any objects and proceed normally, as though you had clicked directly on the 
object.



Object Move
Click on this button to move the current object. The left button controls movement along the X axis by 
mouse movement parallel to the X axis, and movement along the Y axis by mouse movement parallel to 
the Y axis. Using only the right mouse button controls movement along the Z axis.



Object Rotate
Click on this button to rotate an object or objects in the current coordinate system. The left button controls
rotation around the X axis by mouse movement perpendicular to the X axis, and rotation around the Y 
axis by mouse movement perpendicular to the Y axis. Using only the right mouse button controls rotation 
around the Z axis, by mouse movement perpendicular to the Z axis.

An object always rotates around its own center, but the effect of mouse movement during rotation 
depends on the coordinate system currently in use; see below.



Object Scale
NOTE: this function is only available using the 'C' hotkey. See Hotkeys below for more information.

Use this function to scale an object or objects. The left button controls scaling on the X axis by mouse 
movement parallel to the X axis, and scaling on the Y axis by mouse movement parallel to the Y axis. 
Using only the right mouse button controls scaling on the Z axis. If both buttons are depressed, the 
scaling is uniform on all enabled axes    (see Coordinates Panel below).



Coordinates Property Panel
This panel is accessed by right-clicking on an object or view navigation tool. It contains two sets of 
controls:

· The top row consists of three "radio buttons" for setting the current tool's coordinate system. Only 
one can be active at a time. 

· The second row is a set of toggle buttons for enabling and disabling movement on any or all of 
the three coordinate axes. Each can be selected or not, regardless of the other settings.

These controls are replicated as a pop-up menu for the coordinate system and X, Y and Z buttons at the 
right end of the Help Bar, as depicted below, when it is activated via the Help menu.

A good example of viewSpace's versatility is the ability to perform view and object transformations in any 
of three different coordinate systems, depending on which is appropriate for the current situation. For 
example, the Object coordinate system is used primarily for rotation and scaling of sub-objects of 
hierarchical objects. The World coordinate system is used for moving entire objects. The Screen 
coordinate system, used with entire objects, gives you a virtual-reality feel of holding it in your hand.

Note: viewSpace automatically sets an appropriate default coordinate system, depending the tool you're 
using. For example, it uses    World coordinates for object movement, and Object coordinates for object 
rotation and scaling. You can change the default settings at any time.

The Coordinates panel gives you access to these controls. Right-click on any Navigation tool to open the 
panel (see above). The upper row of buttons determines the coordinate system in which a transformation 
is to occur. The lower row lets you constrain transformations to certain axes.

Alternatively, you can use the Coordinates panel at the right end of the Help Bar when it is active, as 
shown above. There are three buttons for enabling and disabling the X, Y and Z axes, and to the left of 
these, a pop-up for setting Object, World or Screen coordinates.

Both panels function identically: that is, they show and allow control of the settings for the navigation tool 
currently in use.

viewSpace's three coordinate systems are:

Related Topics:
Object Coordinates
World Coordinates
Screen Coordinates
X/Y/Z



Object Coordinates
When first loaded, an object's axis is aligned with the world axes. When this icon is selected, all 
transformations take place on or about the currently selected object's axis. So if, for example, a rocket 
were created pointing up, with its Y axis also pointing up, then no matter how it was tilted thereafter, 
movement along the object's Y axis would always make the rocket appear to go forward.



World Coordinates
When this icon is selected, all transformations take place on or about the world axes as shown on the 
grid. If, for example, the rocket in the previous example were to be moved straight up even though lying at
some weird angle, you would move it on the Z axis in the World coordinate system.



Screen Coordinates
When this icon is selected, all transformations take place on or about the screen axes. Think of it as world
axes, only the axes are automatically parallel to the screen. X is always left right, Y is always up-down, 
and Z is always in-out, no matter what the camera orientation. So, for example, an object in the center of 
the screen moved on the Z screen axis (that is, with the right mouse button) always moves directly toward
or away from the camera, and in Perspective mode, changes apparent size.



X/Y/Z
These toggle buttons enable and disable movement, rotation, and scaling on any and all of the three axes
simultaneously, regardless of the coordinate system in use. To disable transformation on or about an axis,
click on its button.

Hint: To perform an operation equally on the X and Y axes, for example making a cylinder thinner, turn off 
the Z axis and use both mouse buttons.



Viewpoint Navigation Tools
The group of tools to the right of    the Object Navigation group is used for navigating and changing the 
view, and is found on all windows. The viewpoint is the "eye" through which the view is seen when a 
window is not set to Camera View. It can be positioned, rotated (only in Perspective view) and scaled 
(zoomed), but unlike camera objects it cannot be seen.

One of viewSpace's strengths is that the user is always aware of his or her position in the 3D workspace 
and of the changes in this "world."    Movement of the viewpoint is clearly indicated by the perspective 
change in the ground plane. While the viewpoint is moving, only the groundplane and the selected object 
(if any) are visible, with the rest of the scene temporarily hidden. When the mouse button is released, the 
entire scene is re-rendered.

Related Topics:
Eye Move Tool
Eye Rotate Tool
Zoom Tool



Eye Move Tool
Click on this button to move the view position in the current window. When you change the view position 
in the Perspective window, you're actually changing the eye position. The left button controls movement 
along the X axis by horizontal mouse movement, and movement along the Y axis by vertical mouse 
movement. The right mouse button controls movement along the Z axis.

Some users prefer the Screen coordinate system for moving the view because it seems the most natural--
Z axis movement is "in and out" of the screen. Others prefer the World coordinate system because it 
provides more natural movement, almost like flying an airplane through the scene. Fortunately, 
viewSpace lets you switch at any time to the coordinate system that works best for the situation at hand.



Eye Rotate Tool
Eye Rotate is only available in the perspective view. Click on this button to rotate the view angle in the 
current window by dragging with the mouse in the window.

Again, the best coordinate system for viewpoint rotation depends on what you're doing. World coordinates
are great for rotating the view around a particular object, or around the world center if no objects are 
selected--like moving along the surface of a sphere centered on the object of interest. And screen 
coordinates work like pan, tilt and bank for cinematographers.



Zoom Tool
The Zoom function lets you change the view to see more or less of the scene as necessary. Click on this 
button to zoom the view in the current window. When you change the view zoom in the Perspective 
window, you're actually changing the eye focal length. Use either mouse button¾there's no zooming on 
individual axes.



Render Tool
The Render pop-up menu is found at the left end of each window's tool group. This tool lets you render 
the current object or all objects to the window whose Render tool you choose. There's also a variant that 
refreshes (redraws) the wireframe view. As with the other tools with pop-up variant menus, you select the 
variant by clicking the left button on the icon, then dragging the mouse slightly. Then drag the mouse to 
the desired variant and release the button.

Access the Render Options panel by right-clicking on any Render tool.

Note: Rendering can be stopped by pressing the Esc key or double clicking the righ mouse button..

Related Topics:
Render Current Object
Render Scene
Refresh Wireframe
Render Options Panel



Render Current Object
Render the current object to the display.



Render Scene
Renders all objects to the display.



Refresh Wireframe
Forces window contents to be redrawn in wireframe mode.



Render Options Panel
Access the Render options panel which is by right clicking on any of the render variants. This allows you 
to set several render effects:    

Related Topics:
Reflection Threshold (RefThr)
Background Color
Opaque
Background Image
Global Environment
Fog
AntiAlias Level
RayTrace
Draft



Reflection Threshold (RefThr)
This is related to the Shininess setting. When an object's shininess is set below this value, no reflections 
are traced for it when ray tracing a scene. This helps save time when ray tracing.



Background Color
You can set a solid background color for rendering. To set a color, select the Background Color button. An
RGB requester appears:

Set a color with the mouse and sliders, or click on the number boxes and set new values from the 
keyboard.



Opaque
If the rendered image is saved in the Targa format, it contains an eight-bit alpha channel to define 
transparency, which can be used in texture mapping in viewSpace, as well as in compositing images in 
other graphics programs. If Opaque is not selected, the alpha channel defines full transparency wherever 
the background appears in the rendered Targa image. Otherwise, the background is rendered in the 
specified color with no transparency.



Background Image
To set a background image, click on the Background Image File Name button and select an image file 
with the file requester. If the image is not the same size as the image to be rendered, viewSpace 
automatically scales it to the proper size during rendering. 

Use the Background Image Switch to enable and disable use of a loaded background image.



Global Environment
A global environment works like a regular environment map but is automatically applied to all objects that 
do not have an individual environment map. You can set a solid color or you can specify an environment 
map. Note that these do not appear in the scene, but are reflected by reflective objects.

To set a solid color, select the Global Environment Color button. An RGB requester appears:

Set a color with the mouse and sliders, or click on the number boxes and set new values from the 
keyboard.

To set a global environment map image, click on the Global Environment Map Image File Name button 
and select an image file with the file requester.

Use the Global Environment Map Switch to enable and disable use of a loaded image.



Fog
An optional fog effect affects object color and shading depending on the distance from the "eye" or 
camera point, creating a convincing illusion of a fogged-out scene. 

Fog Switch
Select the Fog switch to turn the fog effect on. An X appears in the white box to indicate that this feature 
is active.

Fog Color 
Use the Fog Color button to specify the color of the fog. Note that this color affects objects only, not the 
background. For best results, use a solid background, and use the background color for the fog. Use a 
black fog to simulate distance attenuation and medium to light grays for normal fog.

Fog Maximum Percent
Use this setting to determine the relative fog density at and beyond the Far distance.

Fog Extents
A scene with fog normally consists of three zones: the clear zone starts at the eye and ends at the Near 
point; the transition zone, in which the fog gradually becomes thicker, starts at the Near point and ends at 
the Far point; and the "maximum percent" zone starts at the Far point and extends to infinity.    The Near 
setting lets you set the distance in grid squares to the point where the fog starts affecting the scene.    The
Far setting lets you set the distance to where the fog reaches maximum density.



AntiAlias Level
Antialiasing reduces jagged edges in images that should only contain smooth edges. Select the AntiAlias 
switch to turn the fog effect on. An X appears in the white box to indicate that this feature is active. This 
pop-up menu offers four levels of antialiasing: 1X, the default; and 2X, 3X and 4X. The greater the 
antialiasing, the more smoothing of edges, but the longer the amount of time required for rendering.



RayTrace
Enables true ray tracing. Reflective objects accurately reflect their surroundings, refractive transparent 
objects bend light, and all lights set to cast shadows do so. Ray tracing requires longer rendering times 
than usual.



Draft
By default, viewSpace renders objects and scenes at the full video quality of your display. For faster test 
rendering at full size but one-fourth resolution, turn Draft on.



View Select Tool
Used to set the main view mode: perspective (default), top, left, front or camera. Each window can be set 
to a different view, and different windows can be set to multiple camera views simultaneously.

You can also open additional windows showing any of these views. See the New Window Tool section 
below.

Related Topics:
Perspective View
Front View
Left View
Top View
Camera View



Perspective View
Perspective is the default view, being the one in which the program normally starts, and for most users it 
is the most flexible in which to work. In perspective mode, the point of view or "eye" can be positioned 
anywhere, pointing in any direction. However, for precise positioning, it may be a good idea to check your 
set-up from the other, orthogonal views to verify everything is where it should be.



Front View
The front view is orthogonal (no perspective), looking down the world Y axis. The view can be moved and 
scaled but not rotated.



Left View
The left view is orthogonal (no perspective), looking down the world X axis. The view can be moved and 
scaled but not rotated.



Top View
The top view is orthogonal (no perspective), looking down the world Z axis. The view can be moved and 
scaled but not rotated.



Camera View
So named because it is great to see what the camera sees, even when in motion. This is normally done 
with a camera object, but the camera can be any object, even a light source. First select the object that's 
to act as the camera, then select Camera View. The view then switches to that of the selected object, 
which "looks" in the direction of its Z axis.

When a window is set to Camera View, the view is adjusted by manipulating the camera object. The View 
Normalize tool and View Navigation tools are ghosted and not available.



Animation Tool
Selecting the Animation tool opens the Animation property panel, which contains VCR-like controls for 
playing animations and moving between animation frames.    Select the Animation tool with the right 
button to open the Animation property panel.



Animation Panel
Play
First Frame
Last Frame
Previous Frame
Next Frame
Animation Parameters Panel



Play
Renders a animation to screen or disk, in wireframe or solid mode, as specified by the Play property 
panel settings. The animation is always rendered in real time¾each frame is calculated, then immediately 
displayed or saved. 



First Frame
Jumps to the animation's first frame.



Last Frame
Jumps to the animation's final frame.



Previous Frame
Jumps to the animation's previous frame.



Next Frame
Jumps to the animation's next frame.



Animation Parameters Panel
Right-click on the Animation tool to open the Animation parameters panel:

Settings here include the animation start and end frame, whether the current object or the entire scene is 
animated, and looping controls.

Related Topics:
Object/Scene
Loop
Toggle
Start/End



Object/Scene
This determines whether the current object or the entire scene (all objects) is animated when the Play 
button is activated. If two or more windows are open, including the main view, Object animates in all 
windows, but Scene animates only in the active window.



Loop
Repeats the animation forever. Only the Esc key    (or double click of the right mouse button) interrupts it. It can be 
combined with Tog.



Toggle
Plays the animation forward then backward.



Start/End
These values show the current start and end frames for animation preview. By default Start is set to 0, the
first frame, and End is set to the last frame in which animation occurs.

Change either value by clicking on the numbers and entering new values from the keyboard, or clicking 
on the double-headed arrows and dragging left and right. You can also change these in the Project 
window.



Introduction
Attached to the main window is a group known as the Utility group, containing the New Window tool plus 
a tool for controlling various program settings. 



New Window Tool
The New Window tool variants, found only on the main viewSpace window, allow opening of one or more
auxiliary windows in Perspective, Front, Left and Top views. Auxiliary windows have standard Viewpoint 
Navigation and View Select tools as described directly above, as well as Render tools. A window can be 
set to show a Camera view by selecting Camera from its View Select pop-up. These windows can be 
used for everything the main view can, including object manipulation and animation set-up and rendering. 
Orthogonal views can be moved and scaled but not rotated.

Windows can be moved by clicking on the blue text box near the left end of the window bar and dragging, 
and can be resized by the edges and corners using standard Windows mouse techniques. The maximum 
size of auxiliary windows is limited to about one-fourth of the screen resolution. To close a window, click 
once on its Control-menu box, then on the Close item, or simply double-click on the Control-menu box.

Related Topics:
New Perspective
New Front
New Left
New Top



New Perspective 
Adds a new perspective view window.



New Front
Adds a new front view window.



New Left
Adds a new left view window.



New Top
Adds a new top view window.



Settings Panel
Selecting this icon from the Window group opens the Settings panel, in which you can adjust various 
aspects of program operation.

Related Topics:
Dynapick (Dynamic Pick)
OrthoNav
NoEcho
Top Menu
Titles
Threshold Time
Tablet



Dynapick (Dynamic Pick)
With Dynamic Pick on, any time the mouse button is pressed in the design space, an object under the 
cursor is selected for manipulation. This object can then be manipulated using the current tool by 
dragging the mouse¾no additional mouse click is required. The benefit is that many objects can be 
manipulated quickly without extra steps required for selecting each.

If two objects are under the cursor, selection alternates between them with each successive mouse click. 
If more than two objects are under the cursor, selection is most reliable when the cursor is positioned over
a specific object's edge or vertex. If no object is under the cursor, the currently selected object is used.

With Dynapick off, before you can manipulate an object or item in viewSpace's 3D workspace, you must 
first select it by clicking on it with the left or right mouse button without dragging, then releasing the 
button. Turning off Dynapick can help avoid accidental selection of objects while manipulating a complex 
scene.



OrthoNav
Allows left-button-only navigation in the Front and Left views by simulating a 2D interface. This may be 
easier for the user, as manipulation in orthogonal views is likely to be in two dimensions.

viewSpace's orthogonal views¾Top, Front, and Left¾only allow movement of objects and the view 
parallel to the view plane. There's no in/out movement possible in these windows, because, lacking a 
perspective view, such a change wouldn't be visible. Normally, when using the the Front and Left 
orthogonal views, to move an object or a view vertically, you must use the right mouse button, as in the 
Perspective view. To make this particular aspect of viewSpace's interface a bit friendlier, we've provided 
the OrthoNav switch. When it's activated, you can navigate in all orthogonal views using only the left 
mouse button, as in a 2D graphics program. Dragging the mouse horizontally and vertically invokes 
corresponding motion in the orthogonal views.



NoEcho
With NoEcho off, the default condition, when a wireframe object is redrawn, you can see the process on 
the screen. With NoEcho on, the object appears only after the full wireframe has been redrawn. Turn on 
NoEcho for improved feedback with complex wireframe objects.



Top Menu
The default position for viewSpace's menu bar is at the bottom of the screen. If you prefer the more 
conventional position at the top of the screen, select this item.



Titles
When this toggle button is on, all program panels have standard Microsoft Windows title/drag bars across 
the top. These can be closed with a single click on the Close box in the upper left corner.



Threshold Time
As you transform objects in viewSpace's workspace, the program attempts to maintain maximum 
feedback by continually redrawing wireframe objects during manipulations. This is in contrast to other 
programs, which automatically create bounding boxes during any transformation, reducing feedback and 
requiring more time for set-up. However, with complex objects and/or many simultaneously open views, 
forcing everything to continually redraw can cause unwanted delays, in which case the program resorts to
using bounding boxes during transformations.

This setting determines the maximum redraw time before a scene is simplified with bounding boxes while 
transforming objects. The lower the setting, the greater the likelihood that simplification will occur. If you're
working with a complex object and redraw time is taking too long while transforming it, lower this setting. 

If more than one view window is open, the total redraw time in all windows is taken into consideration. If 
not all windows need to be simplified, the current window is simplified last. In other words, if you have a 
small Top view window open and you're dragging a complex object in the main Perspective view, it may 
appear as a bounding box in the Top view but as a wireframe in the Perspective view.

When working with hierarchical objects, there is an additional level of detail between wireframe and 
bounding box, which is hierarchical bounding box. This creates a bounding box for each member of the 
hierarchy, rather than a single one for the entire object. 



Tablet
Enables input from supported graphics tablets.



File Menu
Scene: New
Scene: Load...
Object: Load...
Exit



Scene: New
This clears all objects from the workspace, and leaves all other settings (e.g. Material) as they are.



Scene: Load...
This restores set-ups saved previously with the Scene: Save As... command, including objects, lighting, 
animation, and so on. When the Load Scene file requester appears, select the file to load, then click on 
OK. If you don't see a scene file you saved, select "All Files *.*" from the List Files of Type pop-up at the 
bottom left of the file requester.



Object: Load...
This allows loading of 3D object files. Supported formats, automatically recognized by the viewSpace 
loader, include viewSpace, Wavefront, VideoScape, LightWave 3D, Imagine, DXF (AutoCAD) and 3D 
Studio ASCII and Binary (.3DS) files. viewSpace objects usually have the file name extension ".cob", 
although this isn't a requirement. When the Load Object file requester appears, select the file to load, then
click on OK. If you don't see an object file you saved, select "All Files *.*" from the List Files of Type pop-
up at the bottom left of the file requester.

To restrict the listed files to a particular type, use the pop-up under "List Files of Type:" in the requester.



Exit
Quit the program.



Help Menu
Help Bar
About



Help Bar
Use this item to toggle display of viewSpace's context-sensitive help feature.

By enabling the Help Bar option from the Help menu, you can take advantage of viewSpace's context-
sensitive help mode while learning the program and using unfamiliar tools. When the mouse pointer is 
positioned over any tool icon, the help bar displays its description plus a keyboard shortcut, used for 
accessing the tool from the keyboard.



About
Displays basic program information, including the current display mode. To close the information box, 
right-click on it and drag outward, or if the Titles switch (see below) is enabled, select the Close box in its 
upper left corner. 




